Description of document: Small Business Administration (SBA) Correspondence Style Guide, 2010

Request date: 23-June-2014

Released date: 11-July-2014

Posted date: 11-August-2014

Source of document: Chief, Freedom of Information/Privacy Acts Office
Small Business Administration
409 3rd St., S.W., 8th floor
Washington, DC 20416
Fax: (202) 205-7059
Email: foia@sba.gov

The governmentattic.org web site (“the site”) is noncommercial and free to the public. The site and materials made available on the site, such as this file, are for reference only. The governmentattic.org web site and its principals have made every effort to make this information as complete and as accurate as possible, however, there may be mistakes and omissions, both typographical and in content. The governmentattic.org web site and its principals shall have neither liability nor responsibility to any person or entity with respect to any loss or damage caused, or alleged to have been caused, directly or indirectly, by the information provided on the governmentattic.org web site or in this file. The public records published on the site were obtained from government agencies using proper legal channels. Each document is identified as to the source. Any concerns about the contents of the site should be directed to the agency originating the document in question. GovernmentAttic.org is not responsible for the contents of documents published on the website.
July 11, 2014

Re: FOIA 14-623-2

This is in response to your Freedom of Information Act (FOIA) request for a copy of the U.S. Small Business Administration style manual.

We are releasing the document to you in full.

In accordance with 13 CFR 102.6, we are not assessing fees for processing your request.

We trust that this satisfies your request.

Lastly, in an effort to make SBA more open and responsive, we have created a new Congressional Correspondence FOIA page (http://www.sba.gov/content/congressional-correspondence). There are almost 200 documents on the page, and we are adding more every week. We hope you find it useful and informative.

Sincerely yours,

Kim L. Bradley
Director
Office of the Executive Secretariat

Enclosures
Correspondence
Style Manual

U.S. Small Business Administration
Office of the Executive Secretariat
Correspondence Style Manual

U.S. Small Business Administration
Office of the Executive Secretariat

Updated March 2010
# Table of Contents

**Introduction** .......................................................................................................................... 1

- Who is Exec Sec? .................................................................................................................... 1
- Why are we writing? .................................................................................................................. 1
- Who are the real customers for your response? .................................................................... 2

**The Writing Process** ............................................................................................................. 4

- What do you expect of writing? .............................................................................................. 4
- How do I ensure clarity in writing? .......................................................................................... 5
  - Active vs. Passive Voice ........................................................................................................ 5
  - Content ................................................................................................................................. 5
  - Modifier Placement ............................................................................................................... 6
  - Parallel Structure .................................................................................................................. 6
  - Shifts in Agreement .............................................................................................................. 7
  - Shifts in Subject .................................................................................................................... 7
  - Tone ..................................................................................................................................... 8
  - Word Choice ....................................................................................................................... 8
- What is Plain Language? ............................................................................................................ 9

**Developing Correspondence** ................................................................................................ 11

- What are the limitations of this guide? ................................................................................... 11
- What Fonts should I use? ........................................................................................................ 11
- How do I space properly? ......................................................................................................... 11
- How can I control Pagination? .............................................................................................. 13
- What should the address and salutation look like? ............................................................... 13
- Does SBA have Standard Language? ..................................................................................... 14
- When should I use hyperlinks? ............................................................................................... 14
- What about Symbols, Acronyms, and Abbreviations? .......................................................... 14

**Standards of Writing** ............................................................................................................ 15

- What is in this section? ........................................................................................................... 15
- What’s important about punctuation? ..................................................................................... 15
  - Comma ............................................................................................................................... 15
  - Semi-colon .......................................................................................................................... 16
  - Colon .................................................................................................................................. 17

*Updated March 2010*
Introduction

Who is Exec Sec?

The Office of the Executive Secretariat (Exec Sec) serves as the primary center that supports the Administrator, Deputy Administrator, Chief of Staff, and Associate Administrators through management of incoming and outgoing correspondence. Exec Sec controls all documents addressed to the Administrator and the Deputy Administrator, and all correspondence from the White House, members of Congress, and state officials addressed to anyone in the Agency. All correspondence that should be controlled by Exec Sec generally goes directly to the Exec Sec office, and should be forwarded there if it first reaches your office. If your office receives a piece of controlled correspondence, take it to Exec Sec immediately. Exec Sec has processes in place through an electronic document control system (CRM-CM). In addition to incoming mail, Exec Sec controls all internal documents as well. But we do not input these documents; that is primarily the responsibility of the Program Office.

Exec Sec provides editorial assistance and training through CRM-CM. This system controls, assigns, routes, and tracks executive correspondence. Exec Sec is also responsible for monitoring and facilitating the movement of correspondence throughout the Agency, as well as controlling the use of the AutoPen machine.

Additionally, Exec Sec maintains the National Answer Desk (1-800 U ASK SBA) located in Charlotte, North Carolina. The Answer Desk is the front line for incoming inquiries from current and potential small business owners. The staff there provides information to callers, or refers them appropriately, regarding SBA programs available at the federal, state, and local levels, whether public or private.

Why are we writing?

Increasingly, telephone calls and quickly written emails are replacing letters as common forms of communication. All of us are becoming more familiar with getting information in bullet form, through PowerPoint presentations and the like, than by reading through pages of a document in reports. The challenge we face as we answer controlled correspondence, write notices, or craft memorandums is to provide the necessary information concisely—while still being understood—and conveying the Agency’s knowledge, professionalism, and courtesy.
As it becomes more evident in our “modern” culture that writing is becoming outdated, the necessity of writing is still very clear. While a decent portion of our communication is often limited to a specific number of characters (Twitter or text messages) or quick blurts of how we’re feeling right this second (Facebook and blogs) or speedy responses to a question someone posed to you (email), we still need to be able to develop full-bodied ideas that address a specific topic. There are certainly times when tweeting and blogging are appropriate. However, these purposes are very different from those of developing official correspondence. The incoming correspondence does not dictate the outgoing response. Our responses need to be professional and understandable.

OK. If writing is slowly becoming obsolete in today’s information world, why does SBA expend resources to maintain its focus on written correspondence? There are two major reasons:

- Writing allows us to impart information to people quickly and accurately. It is the fastest, most flexible way customers can acquire the information they need.

- Writing allows us to communicate SBA’s viewpoint and preserve it as a record. It is our best tool for building an institutional memory—a growing challenge in today’s world of fleeting information.

Writing responses to our customers is critically important. Disciplined writing is not the sole route to valuable insight, and it does have weaknesses—like other tools, its value is reliant on the user’s skill. But it is unique in the strength and consistency of the structure it offers.

**Who are the real customers for your response?**

Under most circumstances our primary audience is external—it might be legislators, small business staff, SBA partners, and many other individuals interested in small business issues. Some of this audience is seeking information specific to a personal situation or relationship with SBA; others are looking for general Agency or small business information. Sometimes our communication with the external audience is one-on-one; sometimes it is through mass media (including the Internet, Notices, press releases, etc.).

We also write for an internal audience—Agency leadership and other staff we are seeking to give information to. This internal audience includes people who review correspondence and other written material during the clearance process. This latter group consists of writers and subject matter experts, so it can be the most
challenging audience of all. Different reviewers may have conflicting preferences or viewpoints, clear guidance may not always be available, and consistency may be hard to discern even with a single reviewer. However, a reviewer can offer valuable insights as to subject matter, and can help by identifying issues requiring clarification or correction. Because the role they play is cooperative, reviewers should be considered valuable resources rather than burdensome obstacles.
The Writing Process

What do you expect of writing?

Writing on behalf of SBA can be daunting. But using the proper writing process can limit those demands and help sharpen the responses we develop. Don’t worry—the documents we craft are not expected to be “great reads” or comparable to the works of Mark Twain, Vladimir Nabokov, or Toni Morrison. We are writing so that our message gets through to the audience clearly and quickly. Because space is a consideration, every word must work as efficiently as possible.

<table>
<thead>
<tr>
<th>5 Steps to Correspondence</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Be Courteous</strong></td>
</tr>
<tr>
<td><strong>Be Timely</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>One (1) day</td>
</tr>
<tr>
<td>Five (5) days</td>
</tr>
<tr>
<td>Ten (10) days</td>
</tr>
<tr>
<td>Fifteen (15) days</td>
</tr>
<tr>
<td><strong>Be Responsive</strong></td>
</tr>
<tr>
<td><strong>Be Concise</strong></td>
</tr>
<tr>
<td><strong>Be Clear</strong></td>
</tr>
</tbody>
</table>

Use Plain Language when communicating. This will naturally make the document easier to understand, and make our customers (whoever they may be) happier to read it. When you’re done writing, step back, and determine if your cousin or grandfather or niece could easily understand what you’re sending. (see section on Plain Language)
How do I ensure clarity in writing?

Writing clearly is paramount. If your writing is muddled, then you’re wasting your own time, as well as the customer’s time. While it’s important that you get your document ready quickly, it’s also important that you take care when crafting the document. The following elements are critical when your goal is to write clearly.

**Active vs. Passive Voice**

You can essentially use two “voices” while writing: Active and Passive. The active voice is generally the better option. Using the passive isn’t some kind of unforgiveable offense, but it’s better to not use it. The difference is in the action and whether the subject performs or receives it. The passive voice is lazy—it just sits back and receives the action of the verb. The active voice is busy—it takes the necessary steps to act.

*Passive:*

YOUR DINNER WAS OVERCOOKED.

*Active:*

THE CHEF OVERCOOKED YOUR DINNER.

*Passive:*

THE LAMP WAS BROKEN.

*Active:*

CINDY KNOCKED THE LAMP OFF THE TABLE, BREAKING IT.

**Content**

Keep your information factual and don’t be judgmental. It’s important that the recipient feel comfortable responding. We can make that more likely by maintaining a sense of fairness.

*Wrong:*

WE ARE COMPLETELY SATISFIED THAT JOE SMITH, WHO HAS BEEN A REVIEWER FOR SEVERAL YEARS, HAVING COME TO SBA AFTER A STINT AT THE FARM CREDIT ADMINISTRATION IN OHIO, ACTED PROPERLY AND IN FULL CONFORMITY WITH ALL RULES AND REGULATIONS.

*Right:*

WE DETERMINED THAT OUR EXPERIENCED REVIEWER, JOE SMITH, ACTED PROPERLY AND CONFORMED FULL TO ALL RULES AND REGULATIONS.
MODIFIER PLACEMENT

Modifiers (adjectives and adverbs) are very powerful words. They can make a sentence come to life—or they can make the reader crazy with confusion. The key is to place the modifier (or modifying phrase/clause) in the appropriate location. Knowing when you’ve misplaced a modifier is not always easy when you’re the one writing the sentence, so it’s important to step back and really read what you’ve written. It would be terrible for the reader to be misled because a couple of words are in the wrong place.

WRONG:
RUNNING IN THE HEAT, MY SHIRT STUCK TO MY SWEAT-SOAKED BODY.

RIGHT:
MY SHIRT STUCK TO MY SWEAT-SOAKED BODY WHILE I WAS RUNNING IN THE HEAT.

WRONG:
A MAN OF INCREDIBLE VISION, THE COFFEE POT DEBACLE WAS CLEVERLY SOLVED BY THE DIRECTOR.

RIGHT:
A MAN OF INCREDIBLE VISION, THE DIRECTOR CLEVERLY SOLVED THE COFFEE POT DEBACLE.

PARALLEL STRUCTURE

Parallel structure, also called parallelism, is the practice of keeping similar things written in a similar way. If you’re working with two related ideas, it’s much better to express them in a related and similar way—parallel. Single words are easily balanced with other single words; phrases are easily balanced with other phrases; clauses are easily balanced with other clauses. See? Avoiding parallel structure causes unnecessary awkwardness in the sentence, because it defies the expectations of the reader. (Parallelism can also be used for emphasis.)

WRONG:
NO ONE CAN PERSUADE ME THAT GIVING IS AS MUCH A JOY AS TO RECEIVE.

RIGHT:
NO ONE CAN PERSUADE ME THAT GIVING IS AS MUCH A JOY AS RECEIVING.

WRONG:
THE REPLY NOT ONLY WAS PROMPT BUT ALSO COMPLETE.

RIGHT:
THE REPLY WAS NOT ONLY PROMPT BUT ALSO COMPLETE.
SHIFTS IN AGREEMENT

A common mistake is to shift between singular and plural during the course of a sentence. This is most often done using verbs and pronouns. Again, this is an error that leads to confusion among readers. If they don’t know what you’re saying, they will become frustrated—and that’s not good customer service. So if your subject is single, use singular verbs; if your noun is plural, use plural pronouns.

**Wrong:**

THE TOPIC OF THESE FOUR BOOKS ARE CONSTRUCTION PROJECTS.

**Right:**

THE TOPIC OF THESE FOUR BOOKS IS CONSTRUCTION PROJECTS.

**Wrong:**

EVERY STAFF MEMBER CONTRIBUTED THEIR BEST WORK.

**Right:**

EVERY STAFF MEMBER CONTRIBUTED HIS OR HER BEST WORK.

SHIFTS IN SUBJECT

It’s important to maintain the same subject. If you regularly switch back and forth between specific and nonspecific, it will do little more than confuse the reader. The other common problem is maintaining singular and plural. It’s easy to bounce back and forth between a singular subject and a plural pronoun referencing back. Try to avoid that.

**Wrong:**

WHEN ONE VIOLATES THE RULES, YOU SHOULD BE PREPARED TO ACCEPT THE PENALTY.

**Right:**

WHEN YOU VIOLATE THE RULES, YOU SHOULD BE PREPARED TO ACCEPT THE PENALTY.

**Wrong:**

MR. SMITH’S OFFICE HAS COMPLETED THEIR REVIEW.

**Right:**

MR. SMITH’S OFFICE HAS COMPLETED ITS REVIEW.
Tone

Use conversational but professional language. Express thoughts cordially and tactfully. Avoid outmoded conventions and offensive language. Don’t be negative or evasive. Make smooth transitions between ideas and paragraphs. Don’t treat the reader like a child, or like your friend since childhood.

**Wrong:**
Enclosed herewith please find your application.

**Right:**
I have enclosed your application.

**Wrong:**
Please feel free to call me at your convenience.

**Right:**
Please call me at your convenience.

**Wrong:**
We must receive your response within 60 days from the date of this letter.

**Right:**
Please respond within 60 days.

Word Choice

As simple as this may sound, it is incredibly important to make sure the words you’re using are the ones you intend to use. There are a few word pairs that are commonly mistaken. If you’re ever uncertain, double-check. (For example, accept vs. except.)

**Wrong:**
I cannot except that you’re my father, Darth.

**Right:**
I cannot accept that you’re my father, Darth.

**Wrong:**
I would have gone to bed accept that I had to finish this project.

**Right:**
I would have gone to bed except that I had to finish this project.
What is Plain Language?

When properly used, Plain Language (also called Plain Writing) is understandable at first reading. It is reader-focused writing. It is communication your audience can understand without you needing to clarify. When you write in plain language, you create material that does the work for all people reading that material, including those without a vested interest in the topics at hand.

It’s important to keep your audience in mind at all times during the writing process. As a result, it’s also important to keep thinking about whether you’ve written in Plain Language. If it will help you, then create a checklist (or use one already available). The following table is a compilation of excellent concepts to consider while you’re writing. Remember that our goal is to convey a message to the reader, and to do that, they need to understand what it is we’re saying.

<table>
<thead>
<tr>
<th>Tip</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write for the average reader</td>
<td>Know the expertise and interest of your average reader, and write to that person. Don’t write to the experts, the lawyers, or your management, unless they are your intended audience.</td>
</tr>
<tr>
<td>Organize ideas to serve the reader’s needs</td>
<td>Organize your content in the order the reader needs—the two most useful organization principles, which are not mutually exclusive, are to put the most important material first, exceptions last; or to organize material chronologically.</td>
</tr>
<tr>
<td>Use useful headings</td>
<td>Headings help the reader find the way through your material. Headings should capture the essence of all the material under the heading.</td>
</tr>
<tr>
<td>Use “you” and other pronouns to speak to the reader</td>
<td>Using pronouns pulls readers into the document and makes it more meaningful to them. Use “you” for the reader (“I” when writing question headings from the reader’s viewpoint) and “we” for your agency.</td>
</tr>
<tr>
<td>Use active voice</td>
<td>Using active voice clarifies who is doing what; passive obscures it. Active voice is generally shorter, as well as clearer. Changing our writing to prefer active voice is the single most powerful change we can make in government writing. Active sentences are structured with the actor first (as the subject), then the verb, then the object of the action.</td>
</tr>
<tr>
<td>Uses short sections and sentences</td>
<td>Using short sentences, paragraphs, and sections helps your reader get through your material. Readers get lost in long dense text with few headings. Chunking your material also inserts white space, opening your document visually and making it more appealing.</td>
</tr>
<tr>
<td>Use the simplest tense possible—simple present is best</td>
<td>The simplest verb tense is the clearest and strongest. Use simple present whenever possible—say, “We issue a report every quarter,” not “We will be issuing a report every quarter.”</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td><strong>Explanation</strong></td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td>Use base verbs, not nominalizations (hidden verbs)</td>
<td>Use base verbs, not nominalizations—also called “hidden verbs.” Government writing is full of hidden verbs. They make our writing weak and longer than necessary. Say “we manage the program” and “we analyze data” not “we are responsible for management of the program” or “we conduct an analysis of the data.”</td>
</tr>
<tr>
<td>Use concrete, familiar words</td>
<td>You don’t impress people by using big words, you just confuse them. Define (and limit!) your abbreviations. Avoid jargon, foreign terms, Latin terms, and legal terms. Avoid noun strings.</td>
</tr>
<tr>
<td>Use “must” to express requirements; avoids the ambiguous word “shall”</td>
<td>Use “must” not “shall” to impose requirements. “Shall” is ambiguous, and rarely occurs in everyday conversation.</td>
</tr>
<tr>
<td>Place words and phrases carefully</td>
<td>Placing words carefully within a sentence is as important as organizing your document effectively. Keep subject, verb, and object close together. Put exceptions at the end. Place modifiers correctly—“we want only the best” not “we only want the best.”</td>
</tr>
<tr>
<td>Use lists and tables to simplify complex material</td>
<td>You can shorten and clarify complex material by using lists and tables. And these features give your document more white space, making it more appealing to the reader.</td>
</tr>
</tbody>
</table>

---

**In the end, plain language is defined by its results**—easy to read; easy to understand; easy to use.
Developing Correspondence

What are the limitations of this guide?

This guide does not have the delusions that it knows your content better than you do. The content research is up to you, the writer. But the correspondence we send out represents the Agency. This section will help you decide how the letter looks. It includes fonts, spacing, page numbering, standard language, hyperlink usage, and symbol usage.

What Fonts should I use?

The font is what the type looks like—text style, color, italics, bold, etc. It is important because the reader has to look at it. You want to use a font that helps convey your message easily, rather than a font that detracts from it (detracts from it). While some fonts can certainly be fun, they don’t really help the writer or reader.

Times New Roman has been the standard computer font for some time now. As a result, it is beginning to be viewed as archaic, and other fonts are taking its place. Among them are Arial, Tahoma, Cambria, and Calibri (see chart on the right). This style manual is written primarily in Calibri (14 point). Use one of these fonts, but be consistent. And get your supervisor’s approval before changing fonts. Some may want to keep using Times New Roman. You can set Microsoft Word to use your standard font as the default. However, still use 12-point as your font size.

How do I space properly?

Spacing is a very broad term. It includes the space between letters, between words, between sentences, between lines, between paragraphs. It also includes the alignment, margins around the page, and location of certain elements—the date, page numbers, lines of text. (For examples of many of these items, see Appendix 4, Correspondence Examples. See also Appendix 2, Tips & Tricks)

ALIGNMENT

Left align everything; do not justify. This gives the document a clean look and keeps the rest of the spacing standard. Additionally, do not indent the first lines of paragraphs.

<table>
<thead>
<tr>
<th>Times New Roman</th>
<th>Title Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Times New Roman</td>
<td>Times New Roman</td>
</tr>
<tr>
<td>Arial</td>
<td>Arial</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma</td>
</tr>
<tr>
<td>Cambria</td>
<td>Cambria</td>
</tr>
<tr>
<td>Calibri</td>
<td>Calibri</td>
</tr>
</tbody>
</table>

Small Business Administration
Correspondence Style Guide
Page 11 of 34
MARGINS
Use one-inch (1") margins on all sides. This keeps the Agency consistent, and eliminates awkward and extraneous white space.

LOCATION OF DATE
This should appear at the left margin, on the sixth line (72-points) below the top of the page, or on the third line (18-points) below the bottom of the letterhead logo. The date can easily be inserted as an AutoText field to populate the information when printed.
Note: For correspondence to be signed by the Administrator, omit this field, as there is no guarantee it will be signed on the same day it is printed.

LOCATION OF PAGE NUMBERS
Never put a page number on the first page; it should only appear at the topmost printing space on the following pages. See also the Pagination section below.

LOCATION OF LINES OF TEXT
No part of a paragraph should stand alone at less than 2 lines of text. Any paragraph that spans the page break should have at least 2 lines of consecutive text. This is called the Widow/Orphan (it keeps the text together) and can be easily controlled with the Paragraph formatting function in Microsoft Word (if you use headers for pagination). It is typically set as the default.

SPACING BETWEEN WORDS
There should not be more than one single space between any two words in the body of a piece of correspondence. Also, some words should never be split across lines. To control this, use a non-breaking space. This will ensure that a name, for example, will always appear together on the same line. Other uses include dates and phone numbers. (This is a “Special Character” and requires multiple keystrokes to use. See Appendix 1, Keyboard Drawings; How to type it: Ctrl-Shift-Spacebar)

SPACING BETWEEN SENTENCES
In the beginning, it was standard to use two spaces between sentences. This method is outdated—an old tradition from the typewriter era. Use only one space between sentences.

SPACING BETWEEN LINES
This is “spacing” as most of us have come to know it. We use single-spacing as a rule. If you have some rationale for using a double-space, or a space-and-a-half when writing your document, then feel free to make that adjustment, but be prepared to defend your decision.
SPACING BETWEEN PARAGRAPHS

This is exactly what it sounds like. The paragraph spacing is also known as “before” and “after” and is measured in points. When you hit enter twice after a paragraph, you’re giving it points of space after. A more efficient way of accomplishing the same effect is to use the paragraph formatting to control the 12 points after. This will mean a significant change in the way the formatting of the letter is done. When this is set as a default, it means that each time you hit return, the spacing is 12 more points. You would then have to control this manually when it comes to the date at the beginning and the signature block at the end.

How can I control Pagination?

Ultimately, pagination is only relevant when you’re composing correspondence that spans across more than one page, excluding attachments or enclosures. Since papers can be separated, it’s important to ensure that they can be put back together again if that accidentally happens. So we paginate—we add the page numbers. This can easily be done as an AutoText field, which automatically updates the actual page number without further manipulation by the writer. The first page is never given a page number; numbering always begins on the second page. This format should be consistent throughout the Agency. In order to further control clarity, we include the recipient’s title and name in addition to the page number, and we’re clear that it is the page number. It consists of the recipient’s title and name on one line, and “Page” and the page number on the second, like this (at the top of the second, etc., page):

Mr. Jason Monroe
Page 2

See Appendix 4, Correspondence Examples to see this in practice.

Note: The simplest way to do this is to make it the header, and indicate a “Different first page.” The benefit to this is that it formats automatically both the page number—when AutoText fields are used—and the body of the letter as you approach the second page (see Appendix 2, Tips & Tricks).

What should the address and salutation look like?

The address should include the recipient’s name, title, and address. The salutation should address him or her directly, use the formal title, and end with a colon. There should be 10–12 points of space between the address and the salutation, and another 10–12 points between the salutation and the first line of the body.
The address should not exceed six (6) lines of text, and should spell out the state name (DC is the one exception to this). See Appendix 4, Correspondence Examples to see this in practice.

**Does SBA have Standard Language?**

There is certainly standard language that we use across the Agency. Some of it is quite intuitive, and some is because it properly expresses the Agency’s perspective. See Appendix 3, Standard Language, Symbols, and Acronyms for more.

**When should I use hyperlinks?**

Hyperlinks should never be used for printed correspondence. If the document in question is being distributed electronically, then hyperlinks are fine. But you cannot click on a piece of paper you got in the mail and expect to be redirected to a Web site. All printed materials should have their hyperlinks removed, so the URL or email address is formatted to look just like the rest of the text.

**What about Symbols, Acronyms, and Abbreviations?**

Certain symbols, acronyms, and abbreviations are perfectly acceptable to include in the correspondence you’re writing. Others should be avoided. In general, these devices are used to help the reader understand more easily what he or she is reading, and should only be used to further that goal. Symbols are non-alphanumeric figures that convey the meaning of a word or idea in a more succinct fashion. Acronyms are abbreviated series of words, usually created by taking the first letter of each element (i.e., SBA). Abbreviations are shortened forms of words.

Symbols can generally be used without any prior explanation. Acronyms should always be called out initially, and the acronym itself should immediately follow in parentheses, though some can be used without the initial call-out. Abbreviations are typically spelled out initially, and then shortened from that point forward. See Appendix 3, Standard Language, Symbols, and Acronyms for a list of often used symbols and acronyms.
Standards of Writing

What is in this section?

This section will include standards of writing. It will not include all of them, as that would be far too great a document, but it will include some changes, some explanations, and quite a few examples. For some, this will be eye-opening; for others, this will be groan-inducing. Either way, please remember to use these standards when writing.

What’s important about punctuation?

Punctuation is a powerful piece in your writing arsenal. It can make the difference between insult and praise. For example:

| "A woman without her man is nothing." | "A woman: without her, man is nothing." |

Punctuation comes in many forms. As you might already know, it consists of all the “non-letter” elements of a sentence. This section is not all-inclusive. It does, however, contain some pretty important (and new, for some of you) information. See the GPO Style Manual 2008 (Chapter 8) for a more exhaustive list, with explanations. Some of these are “Special Characters” and require multiple keystrokes to use. For those items, I’ve provided guidance.

COMMA

The comma is quite powerful, if for no more reason than because it is the most-used piece of punctuation (and, as a result, the most misused, also). It’s really quite useful because it allows the writer to make lists, introduce ideas, insert relevant comments, and much more.

USE WHEN...

Making lists of 3 or more items in a series. Insert this comma after each of the items (including before the conjunction—and, but, or, etc.). This is called a serial comma.

WE HAVE COOKIES, ICE CREAM, AND BROWNIES FOR THE APPETIZER.

Having 2 consecutive, distinct words describe something.

THE NEW, FOOLISH PROPOSAL IS PICKING UP STEAM.

Setting off parenthetic words, phrases, and clauses.

I SHOWED UP, WITH THE PAYMENT, ON TIME.

Ahmed, who was in charge, preferred plumbing to carpentry.
An introductory phrase is needed.

**As Chair of the Committee, I developed the agenda.**

**Do not use...**

Between the month and year (but do use it between the date and year).

**We began the program in September 2007.**

When using 2 non-distinct words consecutively to describe something.

**The new loan proposal was approved.**

Before an ampersand (&) (ampersands are used infrequently, and please note they are not merely a replacement for "and").

**My book was published by Little, Brown & Company.**

**Semi-colon**

The semi-colon is useful, but it’s not as much fun as the comma. It is used to distinguish between complete or complex thoughts.

**Use when...**

Two or more independent clauses (complete thoughts) are directly related.

**My friend came over for dinner; we stayed up late playing video games.**

Serial commas make the list items complex or the list items already contain commas themselves.

**The guest list will include Michael Bloomberg, Mayor of New York City; David Letterman, host of The Late Show; and Jeff Bezos, CEO of Amazon.com.**

**Do not use...**

If one sentence is better suited to be separated into two.

**I went to bed early last night. I haven’t slept well recently.**

If a comma can be used instead.

**I saw the stain on the wall, but I wasn’t able to clean it up.**
COLON

The colon is a pointing device. It should be used after a complete thought to indicate that one of the following is coming up: enumeration, explanation, illustration, or extended quotation.

USE WHEN...

Drawing the attention of the reader forward.

**IF IT WASN’T FOR MY COMPUTER I WOULD FORGET EVERYTHING: MY APPOINTMENTS, MY PHONE NUMBERS, AND EVEN MY OWN BIRTHDAY.**

Clarifying what’s already been said.

I ALREADY ATE LUNCH TODAY: A HAM AND CHEESE SANDWICH WITH APPLESAUCE.

DO NOT USE...

When reminding the reader of what’s been said (see em-dash).

DICKENS, HEMMINGWAY, CARROLL—THESE ARE SOME OF MY FAVORITE AUTHORS.

HYPHEN (AND NON-BREAKING HYPHEN)

The hyphen is a connector. That’s what it does—it connects things. It’s never going to have a space next to it. It makes compound words and shows you that a word at the end of a line should really still be together. (An optional hyphen can also be used. It can be inserted at will, but does not appear in print unless appropriate. This allows you to dictate where the hyphen will go, but it does not force you to dictate where the line ends. It can be incredibly useful, but it’s not necessary. **HOW TO TYPE IT: **CTRL-DASH—ON MAIN KEYBOARD)

USE WHEN...

Connecting certain elements of compound words.

**MOTHER-IN-LAW**

A word runs beyond one line and onto the next.

**WE SHOULD BE PREPARED EVERY DAY TO FIND SOMETHING—A WONDERFUL ADVENTURE OF A LIFETIME.**

DO NOT USE...

If a word does not need a hyphen.

**MOTHER BY BIRTH**

The non-breaking hyphen is a very useful piece of punctuation. It does not break at the end of a line, and is used to keep a hyphenated compound word on a single
line of text. It looks like a normal hyphen when printed (but an en-dash when typed, if you have Reveal Style engaged).

**How to type it:**

Ctrl-Shift-Dash—on main keyboard

**USE WHEN...**

A hyphenated word might appear towards the end of a line of text.

WE CAN RECOGNIZE A CONSENSUS, AND SHOULD ADHERE TO EVERYONE’S NEW AGREED-UPON STANDARDS.

**DO NOT USE...**

When you would a normal hyphen: that is, don’t feel obligated to when the word is in the middle or beginning of a line of text.

THE BREAK-IN SCARED THE FAMILY.

**EN-DASH**

So-called because of its size (roughly the width of N), this is often typed as two hyphens. Two hyphens is wrong. Don’t do it. Use the en-dash instead.

**How to type it:**

Ctrl-Minus—number pad

**USE WHEN...**

Showing ranges, signifying “up to and including.”

I WAS IN CANADA JANUARY–APRIL 2008.

**DO NOT USE...**

As part of the range if preceded by “from.”

I WAS IN CANADA FROM JANUARY TO APRIL 2008.
EM-DASH

So-called because of its size (roughly the width of M), the em-dash is a versatile piece of punctuation. This is also often typed as two consecutive hyphens, and this is also wrong. Don’t do it. The em-dash is able to accomplish things that other punctuation can do, but does it with more emphasis.

How to type it:
Ctrl-Alt-Minus—number pad

USE WHEN...

Abruptly stopping and/or changing your thought.

I USED TO BELIEVE I WAS IN GREAT SHAPE—UNTIL LAST SATURDAY’S JOG CONVINCED ME OTHERWISE.

Summarizing what was just said.

SEVERAL SIBLINGS WERE PRESENT—JANET, LATOYA, AND TITO AMONG THEM.

DO NOT USE...

If a comma will suffice.

JAMIE’S PARENT, MARY AND BRIAN, HAVE BEEN INCREDIBLY SUPPORTIVE OF HIM.

ELLIPSIS

The ellipsis is the set of three periods (...). It’s used to indicate an omission of text from a quote. This particular punctuation would not be used in newly developed text. Ideally, this would be used only on rare occasions. For example, if you are quoting from a document (the Code of Federal Regulations, for example), use the entire quote, paraphrase what you’re using (as appropriate), or simply refer the reader to that section while summarizing what you’re trying to convey. If you need to use the direct quote, but it’s too long to be practical, then you can use the ellipsis. But try not to.

USE WHEN...

Extensive quotes need to be cut down.

DO NOT USE...

With short quotes.

With non-quoted text.
Administrator, Deputy Administrator, and Chief of Staff Guidelines

How do these differ?

These are the highest levels of appointment at SBA. Because of their stature, they are arguably the most important. So there are Administrator’s Preferences that need to be considered.

Are there additional requirements for Administrator correspondence?

Yes. Generally, we want to keep correspondence to 2 pages or fewer. A two-page letter with a Fact Sheet attached will be used for any correspondence exceeding two pages. The Fact Sheet will summarize the document and provide information on the subject/issues raised by the correspondent, major points in the response, issues of concern that may not be addressed in the response, contact person, and other pertinent information.

Where can I find the Administrator’s Preferences?

Start by checking Appendix 5, Administrator’s Preferences, and then by contacting your Exec Sec liaison. We will gladly provide you with a copy of the preferences, and walk you through them briefly if you’d like. Additionally, the Exec Sec Writer-Editor has the preferences, and edits all outgoing Administrator correspondence to ensure it complies.

Should I use special stationery?

Technically, yes. Exec Sec is most likely going to print onto Administrator letterhead, and get the document signed. In the event that you are providing the stationery yourself, use the signing official’s stationery, and do not include title in the signature block.
Congressional Correspondence

Is Congressional Correspondence different from other correspondence?

Congressional correspondence goes directly to members of Congress, or their staff. As such, it is very special and must be handled with the utmost professionalism and promptness. Most Congressional mail has a 5-day turnaround time. Certain members of Congress have an even quicker timeframe to be closed out, due to their unique affiliation with SBA and its stakeholders. See Appendix 5, Administrator’s Preferences for those members. There is also, of course, the possibility that the turnaround time for a specific letter will be shortened (or extended) for various reasons. So pay attention to the due date.

What additional requirements exist?

All Congressional mail is reviewed by the Office of Congressional and Legislative Affairs (CLA) and the Office of the General Counsel (OGC). They see the incoming letters and the responses before they are sent out. It is important that the return mail be sent to the appropriate address, either their home office or their district office, and addressed to the appropriate staff member, as applicable. Some members of Congress have their own filing system and request that you reference their system in your response. Don’t forget to do that.

How should these letters be addressed?

All Congressional titles are “The Honorable” regardless of branch (Senate or House) and gender. When addressing the salutation, use the appropriate branch’s designation (Senator, Representative). For examples, see Appendix 4, Correspondence Examples.

As for addressing the letter itself (name, address, attention line as appropriate), you should consider incoming Congressional mail to be directly from Congress. As a result, your response should go directly to the member. The only exception to this is if the incoming letter requests that you respond to the attention of a specific staffer. In this situation, address everything as normal, but include “ATTN: Staffer’s First & Last Name” below the Congress member’s name on the envelope. If you use window envelopes, the Attention line can appear on the letter.
Occasionally, the letter may request that you respond directly to the constituent—if this happens, send a copy of your response to the Senator or Representative as well, and note it as a CC after the signature.

**How should a document from multiple members of Congress be closed?**

When replying to a letter signed by more than one member, address an original to each member. However, in the closing paragraph, state that the same or similar reply is going to each member who signed the incoming letter.

When closing a Congressional letter with multiple addressees with the same title, pluralize the titles.

An identical letter has been sent to Senators Cardin, Snowe, and Hutchison, and Representatives Pelosi and Akin.

This also means that if you’re only sending to one Senator and one Representative, don’t pluralize the titles for either. But if you are sending to two Senators and one Representative, or vice versa, then pluralize as appropriate.
Appendices

Keyboard Drawings
Tips & Tricks
Standard Language, Symbols, and Acronyms
Correspondence Examples
Administrator’s Preferences
Resources
Appendix 1: Keyboard Drawings

Em-dash (—)

En-dash (–)

Non-breaking hyphen (moves hyphenated word to the next line as appropriate)
Non-breaking space (keeps words together, regardless of where they appear)

Optional hyphen (good for words approaching the end of the line)
Appendix 2: Tips & Tricks

In general, I implore you to learn the capabilities of Microsoft Word. It is designed as a word processor, and has many devices that can be of value to you. The Keyboard Drawings are an example, but they are just one example. The following items can be of great help in making your work easier and more efficient. Ultimately, that’s what we all want.

Alignment for All Letters:

Keep the text of the document left-aligned. That’s the default setting, so don’t change it. If you notice that the alignment seems awry (right aligned, centered, or justified), select Align Text Left.

AutoText:

The actual act of numbering the pages in the Headers & Page Numbers section of this Appendix is a form of AutoText. The other key AutoText item that would be useful in correspondence is the Date field. Place your cursor where you want the date. In Microsoft Word 2007, select Insert > Quick Parts > Field...

While in the Field box, select Category: Date and Time; Field name: PrintDate; Date format: April 18, 2010 (or the equivalent formatting); then select OK. That date will change each time you print the document.
Headers & Pagination:

Headers (and Footers) in Microsoft Word can be an easy solution to what is sometimes a difficult problem. Using headers to insert the page number gives the page numbers a fixed position without disrupting the body text in the letter. To accomplish this in Microsoft Word 2007, select Insert > Header (Blank).

This will force you to type information, and you should. Type the Title and Name on one line, and “Page” (without quotation marks) on the second line (change the paragraph spacing too, to 18 points After). While still in the header, select Page Number > Current Position > Plain Number. To make sure the pagination does not appear on letterhead, check to see that the check box for “Different First Page” is selected. Once done, select “Exit Header” to return to the document. This can be done at any point while writing.

Note: Make sure your Widow/Orphan control is turned on if you see a single line of your paragraph’s text at the top or bottom of a page. Start by popping out the Paragraph menu:
... Then make sure Widow/Orphan control is checked in the Line and Page Breaks tab:

**Margins for All Letters:**

Use one-inch margins ("Normal") on all four sides. You can adjust this by using the Page Layout tab. Under certain circumstances, you can lessen the bottom margin to fit a signature.
Appendix 3: Standard Language, Symbols, and Acronyms

Standard Language

Certain groupings should never be separate at the end of a line of text. Among this list of groupings are: names (John Doe), phone numbers, dates, large numbers (85 million, etc.). On those occasions, use the non-breaking space and hyphen (as appropriate).

An excellent way to convey contact information at the end of a letter follows. Consider adopting this language.

Please contact me at (202) 205-6361 or via Jason.Monroe@sba.gov.

For Administrator’s correspondence, use the following sentence as the last sentence (immediately preceding the Closing):

If you have any further questions, don’t hesitate to contact me at (202) 205-6914.

Symbols

The following symbols should always be used. Don’t use the associated words unless the context dictates.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%</td>
<td>Percent</td>
</tr>
<tr>
<td>$</td>
<td>Dollars</td>
</tr>
</tbody>
</table>

Acronyms

The following acronyms are common or standard and used frequently. Some may be used without calling them out initially in certain circumstances (if third column is blank, always call out on first use).

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Full length</th>
<th>Don’t call out</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBA</td>
<td>Small Business Administration</td>
<td>When writing to Congress, other government agencies</td>
</tr>
<tr>
<td>CFR</td>
<td>Code of Federal Regulations</td>
<td>When writing to Congress, other government agencies</td>
</tr>
<tr>
<td>HUBZone</td>
<td>Historically Underutilized Business Zone</td>
<td>Unless specific context dictates</td>
</tr>
</tbody>
</table>
Appendix 4: Correspondence Examples

Single Page Letter:

One-inch margins on all sides; no pagination information; letterhead logo printed.

U.S. SMALL BUSINESS ADMINISTRATION
WASHINGTON, D.C. 20416

October 31, 2010
Mr. Tomas Brown
President
Making It Happen, LLC
1256 Dover Street
Lewes, Delaware 01298

Dear Mr. Brown:

Thank you for your kind letter regarding your exceptional treatment by one of our employees. A copy of your letter has been forwarded to the personnel department and will be included in the employee's file.

So seldom is it that a customer takes the time to write a letter of appreciation that I feel moved to reward your initiative.

Please accept the enclosed certificate, which, when presented, will entitle the bearer to a 10% discount on the merchandise being purchased at that time.

This is but a small token of our appreciation of customers such as you, upon whose satisfaction we have been allowed to grow and prosper in this highly competitive marketplace.

Again, on behalf of our entire organization, a heart-felt thank you.

Sincerely,

Author
Title
Office
October 31, 2010
Mr. Tomas Brown
President
Making It Happen, LLC
1256 Dover Street
Lewes, Delaware 01298

Dear Mr. Brown:

I just read a newspaper article about your new computer center just north of Rehoboth. I would like to apply for a position as an entry-level programmer at the center.

I understand that Making It Happen produces both in-house and customer documentation. My technical writing skills, as described in the enclosed resume, are well suited to your company. I am a recent graduate of DeVry Institute of Technology in Atlanta with an Associate's Degree in

Computer Science. In the program I was assigned to several staff sections as an apprentice. Most recently, I have been a programmer trainee in the Engineering Department and have gained a great deal of experience in computer applications. Details of the academic courses I have taken are also included in my resume. In addition to having taken a broad range of courses, I served as a computer consultant at the college's computer center where I helped train users to work with new systems.

I will be happy to meet with you at your convenience and discuss how my education and experience match your needs. Do not hesitate to contact me.

Sincerely,

Author
Title
Office
## Addressing Congress

<table>
<thead>
<tr>
<th>House of Representatives</th>
<th>DC Office</th>
<th>Home Office</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Honorable Steny Hoyer</td>
<td>The Honorable Steny Hoyer</td>
<td>Member, U.S. House of Representatives</td>
</tr>
<tr>
<td>U.S. House of Representatives</td>
<td>U.S. District Courthouse</td>
<td>U.S. District Courthouse</td>
</tr>
<tr>
<td>Washington, DC 20515</td>
<td>6500 Cherrywood Lane, Ste. 310</td>
<td>6500 Cherrywood Lane, Ste. 310</td>
</tr>
<tr>
<td>Dear Representative Hoyer:</td>
<td>Greenbelt, Maryland 20770</td>
<td>Greenbelt, Maryland 20770</td>
</tr>
<tr>
<td>Senate</td>
<td>The Honorable James Inhofe</td>
<td>The Honorable James Inhofe</td>
</tr>
<tr>
<td>United States Senate</td>
<td>United States Senator</td>
<td>United States Senator</td>
</tr>
<tr>
<td>Washington, DC 20510</td>
<td>1924 S. Utica Avenue, Ste. 530</td>
<td>1924 S. Utica Avenue, Ste. 530</td>
</tr>
<tr>
<td>Dear Senator Inhofe:</td>
<td>Tulsa, Oklahoma 74104</td>
<td>Tulsa, Oklahoma 74104</td>
</tr>
</tbody>
</table>

## Addressing Congressional Committees

<table>
<thead>
<tr>
<th>House of Representatives</th>
<th>Committee Chair</th>
<th>Subcommittee Chair</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Honorable George Miller</td>
<td>The Honorable Carolyn McCarthy</td>
<td>Chair, Committee on Education and Labor</td>
</tr>
<tr>
<td>Chair, Committee on Education and Labor</td>
<td>Chair, Subcommittee on Healthy Families and Communities</td>
<td>U.S. House of Representatives</td>
</tr>
<tr>
<td>U.S. House of Representatives</td>
<td>Committee on Education and Labor</td>
<td>Washington, DC 20515</td>
</tr>
<tr>
<td>Washington, DC 20515</td>
<td>U.S. House of Representatives</td>
<td>Washington, DC 20515</td>
</tr>
<tr>
<td>Dear Mr. Chairman:</td>
<td>Dear Representative McCarthy:</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Senate</th>
<th>Committee Chair</th>
<th>Subcommittee Chair</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Honorable Carl Levin</td>
<td>The Honorable Ben Nelson</td>
<td>Chair, Committee on Armed Services</td>
</tr>
<tr>
<td>Chair, Committee on Armed Services</td>
<td>Chair, Subcommittee on Personnel</td>
<td>United States Senate</td>
</tr>
<tr>
<td>United States Senate</td>
<td>Committee on Armed Services</td>
<td>United States Senate</td>
</tr>
<tr>
<td>Washington, DC 20510</td>
<td>Washington, DC 20510</td>
<td>Washington, DC 20510</td>
</tr>
<tr>
<td>Dear Mr. Chairman:</td>
<td>Dear Senator Nelson:</td>
<td></td>
</tr>
</tbody>
</table>

If the complete address exceeds 6 lines, do not include the name of the parent committee in the address on the letter, but do include it on the envelope address.

## Addressing Congressional Leaders

<table>
<thead>
<tr>
<th>Speaker of the House</th>
<th>President of the Senate</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Honorable Nancy Pelosi</td>
<td>The Honorable Joseph Biden</td>
</tr>
<tr>
<td>Speaker of the U.S. House of Representatives</td>
<td>President of the Senate</td>
</tr>
<tr>
<td>Washington, DC 20515</td>
<td>Washington, DC 20510</td>
</tr>
<tr>
<td>Dear Madam Speaker:</td>
<td>Dear Mr. President:</td>
</tr>
</tbody>
</table>
Appendix 5: Administrator’s Preferences

The Office of the Administrator has requested that Congressional correspondence from Senator Mary Landrieu, Congresswoman Nydia Velázquez, and Senator Olympia Snowe for her signature be written and cleared in 1 day, without exception. If you are a clearing party, please be mindful that your review and clearance is time sensitive, and must allow all clearing parties ample time to process within 1 day. Please work closely with your clearing parties in order to submit your clearances to the Office of the Executive Secretariat within this timeframe.

Any Congressional letter that the Administrator is signing should have the following closing statement:

If you have any further questions, don’t hesitate to contact me at (202) 205-6914.

The Administrator will be signing all documents requiring her signature either by hand or with AutoPen authority by the Administrator, Chief of Staff, and General Counsel in cases where the Administrator is unable to sign.

The Administrator’s preferred closing is “With warmest regards,” and should be followed by 48 points of space (or 3 blank lines) and her name, “Karen G. Mills”:

With warmest regards,

Karen G. Mills
Appendix 6: Resources

Web resources:
HTTP://WWW.PLAINLANGUAGE.GOV
HTTP://WWW.CENTERFORPLAINLANGUAGE.ORG

Print resources: